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 Confidential Information 

This document contains confidential and proprietary data and unauthorized use and disclosure of such information may result 
in damage or considerable loss to Symphony SUMMIT, Inc. The term “Confidential Information” denotes any and all technical 
and business information disclosed in any manner or form including, but not limited to, business strategies, methodologies, 
trade secrets, pricing, software programs, and relationships with third parties, client lists and related information, information 
pertaining to vendors, employees and affiliates. The Confidential Information shall be held in confidence and shall not be used 
other than for the purposes intended, and as specifically stated in the proposal. Further, the Confidential Information may only 
be released to employees and persons on a need to know basis, who shall be obliged to maintain the information confidential 
and the Confidential Information shall not be released or disclosed to any other third party without the prior written consent of 
SUMMIT Software, Inc. 
 
© 2021 Symphony SummitAI. All Rights Reserved. 

  



 
 

Proxy Agent Installation Guide Version: Tahoe 

SUMMIT-ITSM-PAInstall-Tahoe Classification: External Date: 05-19-2021 

  2 

Contents 
About This Guide ........................................................................................................................................ 3 

Audience .................................................................................................................................................. 3 

Typographic Conventions ........................................................................................................................ 3 
Cross‐references......................................................................................................................................................... 3 

Reference Documents ............................................................................................................................. 4 

For Further Assistance ............................................................................................................................. 4 

Chapter 1: Installing and Configuring Proxy Agent .................................................................................. 5 

Overview ................................................................................................................................................. 5 

System Requirements ............................................................................................................................. 7 
Hardware Requirements for Data Collector ............................................................................................................... 7 
Hardware Requirements for Proxy Agent .................................................................................................................. 7 
SummitAI Proxy Setup Tool Software Requirements ................................................................................................. 7 

Installing and Configuring Data Collector Service and Proxy Agent ....................................................... 8 
Installing SummitAI Proxy Agent ......................................................................................................................................... 8 
Installing Data Collector Service........................................................................................................................................ 12 
Installing Proxy Agent ....................................................................................................................................................... 15 
Viewing and Analyzing Log Details .................................................................................................................................... 17 
Service Status Tab ............................................................................................................................................................. 19 
Tools Tab ........................................................................................................................................................................... 20 

Open Configuration Editor ....................................................................................................................................... 21 
Open Unblock Tool ................................................................................................................................................... 22 
Open SAM Auto Upgrade ......................................................................................................................................... 22 
Open SSI Auto Upgrade ............................................................................................................................................ 23 

Mongo DB Tab................................................................................................................................................................... 24 
Description ............................................................................................................................................................... 24 
Installation ................................................................................................................................................................ 24 
Configuration ............................................................................................................................................................ 24 
Troubleshoot ............................................................................................................................................................ 26 

Configuring Single Sign‐On (SSO) for SummitAI ................................................................................................................ 26 
To configure Single Sign‐On session for the customer: .................................................................................................... 27 
To configure storage and forwarding of Asset Data: ........................................................................................................ 30 
Auto Upgrading of Proxy Agent ........................................................................................................................................ 31 

To perform the Auto Upgrade Operation: ............................................................................................................... 33 
Auto Upgrade XML File Details ......................................................................................................................................... 34 

  



 
 

Proxy Agent Installation Guide Version: Tahoe 

SUMMIT-ITSM-PAInstall-Tahoe Classification: External Date: 05-19-2021 

  3 

About This Guide 
Welcome to the Proxy Agent Installation Guide. This document provides the step-by-step instructions 
for installing and configuring Proxy Agent and Data Collector: 
 

• Audience 
• Typographic Conventions 

 
• Reference DocumentsError! Reference source not found. 
• For Further Assistance 

Audience 
This document is intended for the administrators installing Proxy Agent.  

Typographic Conventions 
This document uses the following conventions: 
 
Table: Conventions 
Item Convention 

Buttons boldface font 
Screen Names boldface font 
Field Names boldface font 
Tab Names boldface font 
Screen Elements boldface font 
Module Names boldface font 
 

Cross‐references 

Cross-references to additional or related information within the publication specify the title of 
the section that contains the information. These cross-references represent direct online links. If 
you click the link, the specific section is displayed.  

 

 
 

Note:                                                                                                                                                    
Contains helpful suggestions or references to material not covered in the publication. 
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Reference Documents 
Refer the https://docs.symphonysummitai.com documentation link to navigate to the SummitAI IT 
Management Suite document library which comprises the following list of documents: 

• SummitAI Service Management Online Help 
• SummitAI Asset Management Online Help 
• SummitAI IT Operations Management Online Help 
• SummitAI Procurement Online Help 
• SummitAI Platform Online Help 

For Further Assistance 
If you need any further assistance, contact SummitAI Software support team at: URL: 
https://support.symphonysummit.com/ or write to us at 
summitsupport@symphonysummit.com 

  

https://docs.symphonysummitai.com/
https://summussupport.cloudapp.net/
mailto:summitsupport@symphonysummit.com
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Chapter 1: Installing and 
Configuring Proxy Agent 
Note:                                                                                                                                                                 
SAM Agent supports TLS 1.2 from version 2.5.5.12 or higher. For this, the following components 
must be upgraded to Denali SP3.  

• Web, 
• Proxy  
• Data collector  

For more information, see TLS1.2 Update. 
 
This chapter provides information about installing and configuring SummitAI Proxy Agent. 
 

 Overview 
 System Requirements 
 Installing and Configuring Data Collector Service and Proxy Agent 
 To perform the Auto Upgrade Operation: 

Overview 
The SummitAI Proxy Agent is a software program using which you can install and configure the Data 
Collector and the Proxy Agent. 
 
The SummitAI Proxy Agent helps to configure a Data Collector in the Customer Domain and the Proxy 
Agent in the client environment. You must configure a Data Collector on the Customer Domain in order 
to enable data communication between the Proxy Agent and the SummitAI Database for enabling 
monitoring operations in the Customer Domain. Configuring the Proxy Agent is more suitable to the 
client environment to enable discovering of devices or servers that are part of the client network and for 
posting the gathered information about discovered devices/servers to the SummitAI Database through 
the Data Collector. Always, the data communication happens between the Proxy Agent and the 
SummitAI database through the Data Collector only. 
 
The main components of the SummitAI Proxy Agent are the Proxy Service and the SummitAI Job 
Scheduler. The Proxy Service is a web service that runs in the IIS environment and performs the job of 
receiving, translating, and forwarding the monitored data. The SummitAI Job Scheduler is windows 
service that runs in the back end of the Proxy Agent and performs the job of receiving, translating, and 
forwarding the monitored data. 
 

https://docs.symphonysummitai.com/display/OD/TLS+1.2+Update
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The SummitAI Proxy Agent provides the Graphical User Interface (GUI) for installing and configuring 
Data Collector Service and the Proxy Agents. 
 
In general, you must configure the Data Collector Service in the Customer Domain. To configure the 
Data Collector, you need to specify the database details and SMTP details under the Update Config File 
tab. 
You can configure any number of Proxy Agents across the globe. All these Proxy Agents communicate 
to the central SummitAI Server through the Data Collector. To configure the Proxy Agent, you need to 
specify the proxy details under the Proxy Credentials tab. 
The SummitAI Proxy Agent provides a window to view the error logs and perform high level debug 
analysis under the View Log tab. 
 

You can configure Single Sign-On for SummitAI application using SummitAI Proxy Agent. It is also 
supported with Self-Healing Service, which keeps checking the status of the SummitAI Job Scheduler 
service. These two services support each other. Whenever anyone of the service goes down, the other 
service automatically starts the service within a minute. This helps in avoiding loss of data in the 
monitoring process. 
 

For a Proxy Agent, you can configure settings for both agent-based and agentless monitoring modes for 
specific devices or servers. 
 

To configure agent-based monitoring through the Proxy Agent, you must install the Proxy Agent with 
web services on IIS. To do this installation, you need to use SummitProxyAgent_vXXX_WithIIS.exe file. 
To configure agentless monitoring through the Proxy Agent, you must install the Proxy Agent without 
web services installation. To do this installation, you need to use SummitProxyAgent_vXXX.exe file. 
In the agent-based mode, the data about each device or the server is posted from the agent (Server Agent 
or Asset Agent) that is installed on each device or the server to the SummitAI Database. 
 

In the agentless mode, the SummitAI Server derives the data about each device or the server. In this 
mode, no data is posted from the individual devices or servers. 
 

You can configure the monitoring type for each of the devices or servers as agent-based or as agentless 
mode on the respective device or server configuration pages. 

 

Note:                                                                                                                                                 
For any device or a server, after configuring the monitoring type as “agent-based” mode, it is 
mandatory for you to install the agent on that device or server. Else, no data communication 
happens between the SummitAI Server and the device/server. 

 
To define the monitoring mode for a server: 
On the SERVER LIST page (Operations > Configuration > Servers > Server List) you can Add/Modify 
the Servers. If the Servers are discovered through scan mode, you have the option to select the monitoring 
category, that defines a common monitoring mode for all those servers. 
For more information about configuring monitoring category for servers, see the SummitAI IT 
Operations Management Online Help. 
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To define the monitoring mode for a network device or link: 
On the CREATE VIEW/EDIT VIEW page (Operations > Configuration > Networks > View > Click 
Create View or Edit View) you can configure Network settings. If the network devices or links are 
discovered through scan mode, you have the option to select the monitoring category, that defines 
common monitoring mode for all those devices or links. For more information about configuring 
monitoring category for network devices or links, refer the SummitAI IT Operations Management 
Online Help. 
In the Agent-based monitoring mode, you can fetch more data compared to agentless monitoring mode. 

System Requirements 
This section describes the hardware and software requirements for SummitAI Proxy Agent. 

Hardware Requirements for Data Collector 

 Minimum of 8 GB of RAM (by default) is required here. (The size of the RAM you may need 
to increase if  the number of configured items in the network increases) 

Hardware Requirements for Proxy Agent 

 Minimum of 4 GB of RAM is required here. (The size of the RAM can vary with the number 
of configured items in the network) 

SummitAI Proxy Setup Tool Software Requirements 

 Windows 2003 or higher (32-bit or 64-bit) 
 Internet Information Services (IIS) 7.0 and above 
 DOT NET Framework 4.6.2 and above 
 ASP.NET State Service start type with Automatic 
 Adobe Flash Player 64-bit (to generate Graphical reports for Push Report) 

 

Note:                                                                                                                                                 
You can install the Proxy Agent with or without IIS. 
To configure agent-based monitoring through the Proxy Agent, you must install the 
Proxy Agent with web services on IIS. To do this installation, you need to use 
SummitProxyAgent_vXXX_WithIIS.exe file. 
To configure agentless monitoring through the Proxy Agent, you must install the Proxy 
Agent without web services installation. To do this installation, you need to use 
SummitProxyAgent_vXXX.exe file. 
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Installing and Configuring Data 
Collector Service and Proxy Agent 
This section provides step-by-step instructions to install and configure Data Collector Service and Proxy 
Agent using the SummitAI Proxy Agent. 

Installing SummitAI Proxy Agent 
To install SummitAI Proxy Agent: 
1. Create a folder on the machine where you want to install SummitAI Proxy Agent (SummitAI Server 

or any other machine) and copy the installer files from the SummitAI CD to the newly created folder. 
2. Double-click the SummitProxyAgent_vXXX_WithIIS.exe file. The Welcome To SummitAI 

Installation Wizard window is displayed. 
 

 
 



 
 

Proxy Agent Installation Guide Version: Tahoe 

SUMMIT-ITSM-PAInstall-Tahoe Classification: External Date: 05-19-2021 

  9 

3. The License Agreement window is displayed. Read the license agreement and if you agree to the 
license agreement, select “I accept the terms in the license agreement” option and click Next. You can 
also print the license agreement, if required. 

 
 
4. The Destination Folder window is displayed. 
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5. Specify the destination folder path where the SummitAI Proxy Agent Setup should be installed.  
 

 
 

Note:                                                                                                                                                 
On the machines with 32-bit, the SummitAI Proxy Agent will be installed to C:\Program 
Files\SUMMUS\Proxy Agent. 
On the machines with 64-bit, the SummitAI Proxy Agent will be installed to C:\Program 
Files(x86)\SUMMUS\Proxy Agent. 

 
6. To change the destination folder, click the Change button and select the destination folder from the 

Look in drop-down list and click the Up one level icon to select a folder. After selecting the desired 
path, click OK. 

7. Click Next. The Ready to Install the Program window is displayed. 
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8. Click Install. The Installing Summit Proxy Agent window is displayed. 
 

 
 

9. Click Next. The Installation Wizard Completed window is displayed. 
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10. The SummitAI Proxy Agent has been successfully installed. Now, you can configure the Proxy Agent 
either as a Data Collector Service or as a Proxy Agent. 

 

Installing Data Collector Service 
To install Data Collector Service: 

1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 
Agent > Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 

 

 
You can select one of the options: 
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• Data Collector Service: Select this option to install the Data Collector in the Customer 
Domain. Any data communication between the SummitAI Server and the Proxy Agent or 
the agents (Server Agent and Asset Agent) happens only through the Data Collector. 
Hence, it is mandatory to install a Data Collector in the Customer Domain to enable any 
monitoring services. 

 

Note:                                                                                                                                                 
Server agent is a software program or a service that runs on a server machine with 
the primary purpose of collecting information from the server and pushing it over 
the network to the central location that is to the SummitAI server or the Proxy Agent 
through the Data Collector. 
Asset Agent is a software program or a service that runs on the individual machines, 
with the primary purpose of collecting the machine hardware health and software 
details and pushing it over the network to the central location that is to the SummitAI 
server or the Proxy Agent through the Data Collector. 

 
• Proxy Agent: Select this option to configure the Proxy Agent in one or more machines in 

the client environment. In general, the clients would prefer to enable monitoring of their 
network or server components through the proxy machines. Based on the size of the 
network and the number of devices or servers you want to monitor and the locations, you 
can install the Proxy Agent in an organization. 
For example, if an organization operates from different parts of the globe, they might want 
to install the Customer Domain in a central location and do the monitoring operation from 
this central location, then you would need to install Data Collector in the central location 
and the Proxy Agents in multiple locations. 
 

Note:                                                                                                                                                 
You can select the Require SSL option to enable the secured data communication 
between the Proxy web service and the Data Collector. You can opt for this option, 
only if the machines on your organization network are enabled with Internet 
Information Service SSL feature. 

 
2. After selecting the Data Collector Service option, click Save. The application displays the 

following message: Updated Successfully. 
3. On the Success message window, click OK. 
4. Under the Update Config File tab, provide the DB and other details. 
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In the DB Details section, you need to specify the configured SummitAI database details. 

• Connection Key: The configured SummitAI database connection key is displayed in 
this field. 

• Server Name: Enter the configured SummitAI Database Server name in this field. 
If you are installing the SummitAI database and the Data Collector on the same machine, then 
you must specify the Server Name in this format: 
Local\<SQL Server Name> 

If you are configuring the data collector server in a different machine, other than the SUM- MIT 
database server, then you must specify the server details in this format: <IP address of the 
SUMMIT database server\<SQL Server Name> 
Example: 10.99.8.101\SQL EXPRESS. 

• Next in the User name and Password fields, you need to specify the user credentials 
that you have configured during the SQL server setup. 

• In the Database field, enter the database name created during SQL installation. 
 

In the Other Details section, you need to specify the SMTP protocol and e-mail details. 
• SMTP IP: Enter the SMTP protocol IP address in this field. 
• SMTP Port: The default configured SMTP Port number is displayed. Do not make any 

changes here. 
• SSL: You can select this option, if the SMTP server is enabled with SSL feature and 

provide the user credentials. 
• In the SMTP User name and Password fields, you can specify the configured SMTP 

user credentials, if required. (Optional) 
• From EmailID: Enter a common or a group email address from which all the alerts, 

notifications, and any other mails should go to the configured application users. 
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• Redirect All Mails: Enter the e-mail address of the recipient to whom all the 
communication e-mails from the application have to be sent. This is mainly used 
during in debugging mode from the testing team, to validate, if the e-mails from the 
application are sent to the recipients properly or not. 

• Internet Proxy: (Optional) If the client network is using Internet proxy to access 
Internet sites, you need to specify the proxy details here. 

5. After specifying all the details under this tab, click the Save button to complete the Data 
Collector configuration. 
If you want to reconfigure the new Data Collector details, click the Reset button. 

Installing Proxy Agent 
To install Proxy Agent: 

1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 
Agent > Summit Proxy Configuration option). Select Primary Proxy. 

 
 

2. Under the Proxy Credentials tab, specify the SummitAI URL and the authentication details. 
• SummitAI URL: Enter the configured SummitAI application URL. The URL is 

displayed in this format: http:// <IP address of the Data Collector Server>//<Virtual 
Directory Name>. Example URL: http://10.99.8. 101//SummitProxyService>. Click 
Update. After the URL is updated, type in details under the Authentication section. 

http://10.99.0.8/
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• In the Authentication section, specify the configured SummitAI application user 
credentials (Login ID and Password) created during SummitAI installation. This is 
required to enable AD authentication through Proxy Agent and also to import data 
from AD. 

 

 
 

3. Under the Internet Proxy tab, select any one of the following options: 
• No Proxy: Select for no proxy settings. 
• Auto-detect: Select to auto-detect the proxy. 
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• Custom: Select to customize the proxy settings. Type in the server name. If you select 
Credentials Required check box, you need to specify Domain, User Name, and 
Password. 

• Click Update. 
 

 
 

Note:                                                                                                                                                 
In the absence of IIS environment, you can use the ʺSummitProxyAgent_vXXX.exeʺ file, 
to configure the Proxy Agent. Using this exe file you can only configure Proxy Agent 
and cannot configure Data Collector. When the Proxy Agent is configured using this exe 
file, the Update Config tab is not displayed in the Proxy Setup Tool window. 

Viewing and Analyzing Log Details 
You can view the Log details under the View Log tab of Proxy Setup Tool window for both Data 
Collector and the Proxy Agent. The log file contains the log information that is captured during the 
monitoring process and while installing or upgrading Proxy Agent or Data Collector. 
 
To view the log details: 

1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy Agent 
> Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 

2. Next, go to View Log tab. 
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Under the View Log tab, you can do the following: 

• In the View Log Text Area, you can view the log information that is captured from 
the monitoring operations or any installation or upgrade steps that are executed. 

• You can select the Enable Debug Log check box and click the Save button to view 
debug log details. With this option, the user can perform high level debug analysis 
with reference to any data communication issue or the installation or upgrade 
problem. 

The log information is useful to analyze and to determine if the data communication is 
happening between the Data Collector server and the Proxy Agent. If there is connection 
loss between the Data Collector server and the Proxy Agent, the logs display the reason 
for the error. The user can view the log information and try to rectify the error without 
any technical support. For example, if the user has changed the password in the 
application and not updated the same password in the Proxy Agent tool, the 
communication between the Data Collector server and the Proxy Agent is lost. The debug 
logs display that the connection error and the reason for the connectivity loss. This helps 
the user to rectify the problem by viewing and analyzing the debug logs. 
• Refresh In Sec: You can specify the time in seconds, after that time interval the log 

information is refreshed in the View Log Text Area. By default, the logs get refreshed 
every 60 seconds. You can also configure the interval at which the data should be 
refreshed. You can also click the Refresh button to view the data instantly in the View 
Log Text Area. 

• If you want to view other log files and go to the common log folder where all the log 
files are stored, click Open Log Folder. The default Log Folder path is 
“..\\SUMMUS\Proxy Agent\bin\logs”. 
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Note:                                                                                                                                                 
During connectivity loss between the Proxy Agent and the Data Collector, the 
application supports storing the collected data on the Proxy Agent and when 
the connection is re- gained, the stored data is pushed to the Data Collector. 
Only hard disk, CPU, and memory monitoring data are stored here. During the 
connectivity loss period, the collected data is stored in the following 
path:..\\SUMMUS\Proxy Agent\bin\DisConn. 
When a job is running, and the connectivity is lost, a log is entered in the 
XML@Proxylevel file in the folder UPDATESTATUSFAILED. An XML file is 
generated on the failure of a job status update to the server. The file contains 
the details of the server, such as duration, last communicated time, and 
message. 

Service Status Tab 
You can view the Service Status tab of the Proxy Setup Tool window for both Data Collector and 
the Proxy Agent. 
Under the Service Status tab, you can view two services (Summit Job Scheduler and Self-Healing 
Service). These two services play a vital role in the data communication between Proxy Agent 
and the Data Collector in the monitoring process. Both services support one another. 
The Self-Healing Service monitors the SummitAI Job Scheduler service and ensures that the 
Scheduler Service is continuously running. The Self-Healing Service checks the status of the 
SummitAI Job Scheduler every one minute and if the scheduler is stopped, within a minute the 
Self-Healing Service automatically starts the scheduler again. The SummitAI Job Scheduler 
service monitors and executes all the jobs. If the SummitAI Job Scheduler stops, the monitoring 
of the Proxy Agent is lost, hence, it is important to keep the SummitAI Job Scheduler up and 
running all the time. 
If the Self-Healing Service is stopped, the SummitAI Job Scheduler service starts it again. To view 
the Service Status tab: 

 
1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 

Agent > Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 
2. Next, go to Service Status tab. 
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• In the Proxy Service Process section, you can view the status of the Summit Job 
Scheduler service. 

• In the Self‐Healing Service section, you can view the status of the Self-Healing 
Process status. 

• You can start or stop or restart both the services together using the Start or Stop or 
Restart buttons. These buttons are useful for debugging purpose or while performing 
installation or upgrade of Data Collector or Proxy Agents. 

• You can use the Refresh option to view the current status of the services. 

Tools Tab 
You can open the Tools tab and perform the following activities: 

 Open Configuration Editor 
 Open Unblock Tool 
 Open SAM Auto Upgrade 
 Open SSI Auto Upgrade 

 

 



 
 

Proxy Agent Installation Guide Version: Tahoe 

SUMMIT-ITSM-PAInstall-Tahoe Classification: External Date: 05-19-2021 

  21 

Open Configuration Editor 

1. Click Open Configuration Editor. The Application Settings section is displayed. 
 

 
 

2. Under the Application Settings section, there are two check boxes for Show Keys: Only If 
Exists and Not Exists. Click Only If Exists check box to see the keys existing in the 
Web.config file. 

3. Select or type in the appropriate values in the right column of all the keys. 
4. Click Save Settings. 
5. Click Done. 

 

If you select Not Exists, it shows the keys that are not existing in the Web.config file. Select 
the key that you want to add to the Web.config file and click Add Config. Key. 
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Open Unblock Tool 

1. Click Open Unblock Tool. The SummitAI Support window in displayed. 

2. Type in the path of the file, that you want to unblock, in the Folder Path field. 
3. Click Unblock Tool. 

 

Open SAM Auto Upgrade 

1. Click Open SAM Auto Upgrade. The SAM Auto Update Configuration window is 
displayed. 
 
 

Note:                                                                                                                                                 
The SAM Auto Update check box is selected by default. 

 

 
 

2. Type in the version, that you want to upgrade to in the Agent Upgrade To Version field. 
3. Type in the location of the proxy server in the SummitAI Proxy Base URL field. 
4. Click 1. Enable Auto Update to enable the settings for Auto Update. 
5. Click 2. Validate Config. 
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Note:                                                                                                                                                 
You can click 3. Disable Auto Update to disable the Auto Update. 

 

Open SSI Auto Upgrade 

1. Click Open SSI Auto Upgrade. The SSI Auto Update Configuration window is displayed. 
 

Note:                                                                                                                                                 
The SSI Auto Update check box is selected by default. 

 

          
 

2. Type in the version that you want to upgrade to in the Agent Upgrade To Version field. 
3. Type in the location of the proxy server in the SummitAI Proxy Base URL field. 
4. Click 1. Enable Auto Update to enable the settings for Auto Update. 
5. Click 2. Validate Config. 

 

Note:                                                                                                                                                 
You can click 3. Disable Auto Update to disable the Auto Update. 
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Mongo DB Tab 
 Description 
 Installation 
 Configuration 
  

Description 

MongoDB is used as a local storage (file system) with load balancing and data replication features. 
Mongo DB can be used with the proxy agent in such a way that the data collector and Mongo DB will be 
in the same server, whereas data collector, Mongo DB and SQL server will be in the same 
network. Mongo DB works here as an intermediate data storage which has a scheduler to push data into 
SQL server. If enabled, data is stored in the Mongo DB first. 

Installation 

1. Click on the link below to download the setup: 
https://symphonysummit.blob.core.windows.net/buildsummit/Mongodb3.6.0-
Redis3.2.100- Software-x64.zip 

2. Install the downloaded files in the below mentioned order: 
a. mongodb-win32-x86_64-2008plus-ssl-3.6.0-signed.msi. 
b.  Redis-x64-3.2.100.msi 

3. Update the SummitAI data collector and open MangoDB tab in the SummitAI Proxy 
Configuration tool. 

Configuration 

1. Select the Enable Mongo DB Data Storage check box. 
2. Under the Mongo Server Configuration section, select the installation path for the Mongo 

Server field (Example: C:\Program Files\MongoDB\Server\3.6\bin\mongod.exe). 
3. Specify the location for saving the supporting files in the Mango DB Path field. 
4. Click Configure MongoDB button and the tool saves the supporting files to the location 

specified in the Mango DB Path field. 

https://clicktime.symantec.com/a/1/3b7b1ELsAUVNzMHGnMzuyCkuagAtlLZM01Uv_OnIeVo%3D?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
https://clicktime.symantec.com/a/1/3b7b1ELsAUVNzMHGnMzuyCkuagAtlLZM01Uv_OnIeVo%3D?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
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5. After configuration, click Install Service to install the services required for Mongo DB. A 
service named “MongoDB” is created and runs in Services.msc on Windows OS. 
 

Note:                                                                                                                                                 
To remove an already created service, click Remove Service. 

 
6. Under the Mongo DB Configuration section, specify the IP address of the Mongo DB server 

or mention it as local host in the Server Name field. 
7. Type in Redis Server IP Address: 6379 or localhost:6379 in the Redis Sever field. 
8. Click Save. 
9. Click Install Scheduler Service to install the scheduler for Mongo DB to transfer the data 

into the SQL server. 

Note:                                                                                                                                                 
The above configuration works only for posting the data from the SAM Agent. If the 
SSI Agent is installed, follow the DC Configuration instead of configuring Mongo DB. 
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Troubleshoot 

Issue Symptom Solution 

Mongo DB 
installation Failure 

You receive an error message: ʺThe 
program can't start because api-ms-
win-crt-runtime-l1-1-0.dll is missing 
from your computer, try reinstalling 
the program to fix this problem.ʺ 

Click on the link below to 
download the package for the 
required OS and install 
accordingly: 
https://support.microsoft.com/
en-us/help/2999226/update-for-
universal-c-runtime-in-
windows  

Configuring Single Sign‐On (SSO) for SummitAI 
Single Sign-on (SSO) is a session or a user authentication process that permits a user to enter one- time 
user name and password in order to access multiple applications. The process authenticates the user for 
all the applications they have been given rights to at the active directory and eliminates further prompts 
when they switch applications during a session. 
 

The Proxy Agent supports configuring of the Single Sign-On session for SummitAI application in the 
customer environment. After configuring this SSO session, the clients can access the SummitAI 
application modules by logging into the system using windows domain user credentials. The 
architecture of the Single Sign-On implementation is shown here: 
 

 

https://clicktime.symantec.com/a/1/JJWiik63q0lG9MroQfeWCspELQcJvm9e_EnqxNB0AZA=?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
https://clicktime.symantec.com/a/1/JJWiik63q0lG9MroQfeWCspELQcJvm9e_EnqxNB0AZA=?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
https://clicktime.symantec.com/a/1/JJWiik63q0lG9MroQfeWCspELQcJvm9e_EnqxNB0AZA=?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
https://clicktime.symantec.com/a/1/JJWiik63q0lG9MroQfeWCspELQcJvm9e_EnqxNB0AZA=?d=1589rwMcs4sJ-y1axwpGMnBER2sv3yljy4_wp4ZLQl8TCR8GDL0_rSsMJGxqaRHshRGbTs5E15SSkM9x9bnsVR4g6QVqqpC2OpzZs5mA4AXdvSBDLs-dIshYI6YwuAvxzNS4Qnb3xEpN7-YyQ6cc4obs8rXV2B8a5aVMQFd7eX5odHyExBBcUEWIJzhenyMEjJ3j6lfliuxKYuqcAMYguE8QkzwQEfAbXnixD3x7VFwiSniuAXXlsBfbg01GMAjFAuLnmaGEPvX0zao7wpDeYs9SfU-u_idnhCbyrJ6RZNhE-GkzdqP-a1j982enh-euHK9x6_LjO9At225NoVTRLwr9VQjd29WYPAUv9R_BP89UNqKGPntfXJx_i9cO8SwliGTFWz05vaoGfl6OjN2kjur8vcRKy9R0ktzuZqWM4PeE67FILENAME
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The following steps are executed in the Single Sign-On configuration. 
 Step1 – The client user request (Proxy URL) for accessing the SummitAI application is sent 

to the client Proxy Agent. 
 Step2 – The client proxy checks for authentication of the user credentials with the respective 

client’s Active directory. After successful authentication, the step 3 is executed. 
 Step3 – The request is re-directed to SummitAI web. The application authenticates the user 

credentials with the application user list. If the user details are configured in the application, 
the SummitAI web home page is displayed. The user can access the application modules, 
features, instances, as per the defined configuration in SummitAI. Else, an error is displayed. 
You need to contact the application administrator to add you as the application user. 
 

Note:                                                                                                                                                 
You can configure the Single Sign-on details in one or more Proxy Agents based on the 
needs of the network setup. 

 

To configure Single Sign‐On session for the customer: 
1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 

Agent > Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 
2. Next, go to LDAP tab. 
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• LDAP Path: Enter the path of the client’s LDAP directory server here. 
• In the Username and Password fields, enter the configured LDAP user credentials to 

get access to the LDAP directory server. 
• Org ID: Displays the configured Org ID. In the On-premise setup, the Org ID value 

will be “1”. In the SaaS setup, there will be ‘X’ number of Org IDs. For each 
organization, a unique Org ID will be assigned. Based on the specified authentication 
user details on the Proxy Credentials page, the corresponding Org ID is displayed 
here. This is the read-only field. 

• User Windows Authentication: While configuring Single Sign-On, you can enable 
user authentication with application using NT Login or Form Login ID. You need to 
select this check box based on the user Log type configuration, selected in the 
Configure Summit User > Access tab. If you select the Log Type as NT Login in the 
Configure Summit User > Access tab page, select this check box. If you select the 
Log Type as Form Login in the Configure Summit User > Access tab page, clear this 
check box. 

• SummitAI Web URL: Enter the SummitAI Web URL. Click Save to save all the 
details. 

 
3. After saving the LDAP configuration tab details, you need to perform the following settings: 

• Open the Control Panel window and go to IIS directory. 
• In the Run command window, type ‘inetmgr’ or from the Start > Control Panel > 

Administrative Tools > Internet Information Services (IIS) Manager and click OK. 
• The Internet Information Services (IIS) Manager window is displayed. 
• Go to SSO directory (Sites > Default Web Site > SummitProxyService > SSO) and open 

the Authentication folder. 
• Under the Authentication folder, ensure to enable the “Windows Authentication” 

option and disable all other options. 
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• Next from the SSO folder again, click the Default Document icon. 
 

 
 

• In the Default Document folder, add Set Default Document as “ProxyLogin.aspx”. 
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To configure storage and forwarding of Asset Data: 
If Proxy Level is selected in the Configure Server tab: 

1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 
Agent > Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 

2. Go to Asset Config. tab. The Proxy Level: Enable Store and Forward For? section is enabled 
and Data Collector: Enable Store and Forward Data section is disabled by default. 

 
 

3. Select the check box corresponding to the data type under Proxy Level: Enable Store and 
Forward For? section. 

4. Click Save. The asset agent data is stored in the proxy server, and then is posted to the server 
based on the job scheduled under Custom Scheduler. 

 
If Data Collector Level is selected in the Configure Server tab: 

1. Open the Summit Proxy Configuration window (Start > Programs > SUMMIT > Proxy 
Agent > Summit Proxy Configuration). The Proxy Setup Tool window is displayed. 

2. Go to Asset Config. tab. The Data Collector: Enable Store and Forward Data section is 
enabled and Proxy Level: Enable Store and Forward For? section is disabled by default. 
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3. Select the check box corresponding to Enable At DC Level to enable storage at Data Collector 
level. 

4. Specify the path where all the proxy data will be collected in the Storage Path: field. 
5. Click Create DC Scheduler and configure Data Collector Scheduler. 

 

Note:                                                                                                                                                 
The Create DC Scheduler button is disabled if DC scheduler is already configured. 

 
6. Click Save. The asset data is saved and based on the DC Scheduler configured, data is 

pushed to database in controlled manner. 

Auto Upgrading of Proxy Agent 
The Auto upgrade feature in Proxy Agent is supported from v5.6 onwards. The auto upgrade feature 
allows to upgrade the Proxy Agents automatically from the central location (Data Collector) by pushing 
the files to the configured Proxy Agents in the network. In a bigger network setup, where thousands of 
Proxy Agents are installed and all these Proxy Agents communicate with the SummitAI server through 
single Data Collector, upgrading the Proxy Agent to a higher version manually is tedious process and 
time consuming. 
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Note:                                                                                                                                                 
Proxy auto-upgrade will work from v5.6 onwards. In order to enable the auto-update for the v5.6 
or lower v5.7 proxies, the Administrator needs to place the newer “AutoUpdateConsole.exe” file 
under proxy folder C:\Program Files (x86)\SUMMIT\Proxy Agent\bin\AutoUpdateConsole.exe. 
For Lesser than v5.6, we cannot auto-upgrade because the Data Collector has new encryption 
whereas proxy will have older encryption that will not be authenticated for auto-upgrade. 
 

 
The auto upgrade feature supported in the Proxy Agent v5.6 onwards and helps to perform this step 
automatically from the Data Collector with fewer steps. 
 
If Exists(Select 1 from Common_Master Where CM_Type='ProxyLatestVersion') Begin 
Declare @Version nvarchar(25) Set @Version = '5.7.2.1' 
Update Common_Master set CM_Value=@Version Where CM_Type='ProxyLatestVersion' End 
In Set @Version = '5.7.2.1' line change the version number (5.7.2.1) with the version number you want to 
upgrade. 
 
An example of the architecture of the Proxy Agent Auto Upgrade implementation is shown here: 
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In this image, you can view that after the version verification, the auto upgrade operation is done only 
in the Proxy Agents, in which the current version is v5.6. In the Proxy Agent with v4.0.3, the auto upgrade 
operation is not happened. 
The sequence of steps that needs to be performed before the auto upgrade operations are given here. 

 Step1: Check if the version of the Data Collector is earlier than v5.6. If yes, uninstall the Data 
Collector and install the v5.6 Data Collector. If the Data Collector version is v5.6 or higher, 
you can skip this step. 

 Step2: Copy the proxy auto update installer files from the SummitAI CD (<Summitnstaller 
CD>\Summit<version no>\ProxyAutoUpdate) and replace these files in the Data Collector 
Proxy Agent folder: ..\\SUMMIT\ProxyAgent\ProxyAutoUpdate 
On the machines with 32 bit, the SummitAI Proxy Agent will be installed to C:\Program 
Files\SUMMIT\Proxy Agent. 
On the machines with 64 bit, the SummitAI Proxy Agent will be installed to C:\Program 
Files(x86)\SUMMIT\Proxy Agent. 
 

Note:                                                                                                                                                 
It is recommended to install new version of proxy in one machine manually and 
configure the proxy server completely (Including DC URL). Further, delete 
(~\SUMMIT\ProxyAgent\bin\Data\ProxyUser.xml) file and then zip the entire folder 
as “AutoUpgradeFiles.zip” and place it under 
~\SUMMIT\ProxyAgent\ProxyAutoUpdate\AutoUpgradeFiles.zip. 

 
 Step3: The auto upgrade step is executed based on the commands defined in the 

AutoUpgrade xml file. After performing these manual steps, you need to open the PROXY 
VIEW page (Admin > Basic > Infrastructure > Proxy View). 

 Step4: On the PROXY VIEW page, select the set of Proxy Agents to which you want to auto 
upgrade the Proxy Agent and specify the schedule time for the same. The Proxy Agent 
creates an one-time job in the scheduler for all the selected Proxy Agents and executes the 
auto upgrade commands as defined in the AutoUpgrade xml file. After the successful auto 
upgrade operation, the status is updated on the PROXY VIEW page. You can view the 
change status details in tabular mode. 

To perform the Auto Upgrade Operation: 

1. From the SummitAI home page, open the PROXY VIEW page (Admin > Basic > 
Infrastructure > Proxy View). 

2. All the Proxies are displayed in Graphical View by default with active Proxy Agents and the 
corresponding status details. 

3. Select Tabular View to switch to the Tabular View mode. 
4. In the tabular view mode, the Current Version and the Latest Available Version of the Proxy 

are displayed. If the current version of the proxy is earlier than the latest proxy version, you 
might need to perform auto upgrade operation for those proxy machines. The Proxy Agents 
that require upgrade operation are highlighted under the Current Version column. 
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5. You can select the check boxes against each of the Proxy Agents, for which you want to 
perform the auto upgrade operation and click the UPGRADE PROXY button. In addition, 
you can specify the date and time duration for the auto upgrade operation using Scheduler 
field. 

6. Click Submit. After clicking the Submit button, you can notice the change in the status as 
ʺScheduled for upgradeʺ for the selected Proxy Agents for auto upgrade operation. At this 
instance, the application creates the one-time job for each of the Proxy Agents and exe- cutes 
that job on the configured scheduled time. After the successful upgrade operation, the status 
of the Proxy Agent is displayed in the Auto Update Status column. 

 
If the Auto Update Status is Passed, indicates that the auto upgrade is successful. 
Also, you can notice the current version of the Proxy Agents changed to the latest version. 
If in the Auto Update Status column the value is displayed as Failed, it indicates that the auto 
upgrade operation was not successful. You can refer to the log files to find the reason for failure. 

 

Warning:                                                                                                                                                 
While executing the auto upgrade commands, the Proxy Agent will be in the 
down state. Hence, you might notice some data loss during that period. 
For more information about Proxy View details, see Proxy View page of the SummitAI 
Platform Online Help. 

 

Auto Upgrade XML File Details 
You can view the AutoUpgrade.xml file included as part of the Auto upgrade installer files. This XML 
file contains all the commands that are required to execute the auto upgrade task in all the selected Proxy 
Agent machines from the central Data collector. 
 
The description of each of the commands in this xml file is given here. The administrator can edit these 
file commands based on the requirements and execute the auto upgrade operation. 
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The description of the section in the auto upgrade xml file is given below: 

 Tag1 Section  
<VersionCheck Name=ʺSummit_ProxyConfiguration.exeʺpplyThisVersion=ʺNoʺ 
BaseURL=ʺhttp://localhost/SummitProxyService/ProxyAutoUpdate/4.0.1.2/ʺ/> This tag 
compares the current version of the proxy with the proxy version specified in “Version” tag, 
if it is lower than the specified version, the Proxy Agent upgrades it to the latest version. 
• Name tag contains the assemble file name and Version tag contains the version of the 

specified assembly file for auto upgrade. 
• If ForceApplyThisVersion tag value is specified as “No”, the proxy upgrade is done for 

those Proxy Agents in which the proxy version is higher than the value specified in the 
Version tag. 

• If ForceApplyThisVersion tag value is specified as “Yes”, the proxy upgrade is done for 
those Proxy Agents in which the proxy version is not matching with the value specified 
in the Version tag. 

• BaseURL tag contains the URL path for downloading the auto upgrade files from the Data 
Collector. 
 

 Tag2 Section 
In this tag section, you can specify the list of files to download for auto upgrade task in the 
zip or the file format from the server to the Proxy Agent. 
<Zip>AutoUpdateFiles.zip</Zip> 
<File>Summit_ProxyServer.exe</File> 
<File>ProxySelfHealingService.exe</File> 
• In the <Zip> tag section, specify the zip file name in this tag. 

http://localhost/SummitProxyService/ProxyAutoUpdate/4.0.1.2/
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• You can specify the Assembly file or any other files in the <File> tag. 
 

 Tag3 Section 
In this tag section, you can specify the list of files to download for auto upgrade task in the 
zip or the file format from the server to the Proxy Agent. 
<Zip>AutoUpdateFiles.zip</Zip> 
<File>Summit_ProxyServer.exe</File> 
<File>ProxySelfHealingService.exe</File> 
• In the <Zip> tag section, specify the zip file name in this tag. 
• You can specify the Assembly file or any other files in the <File> tag. 

 
 Tag4 Section 

In this tag section, you can specify the list of process names without extensions in the Name 
tag to stop the processes before starting with the auto upgrade task. 
<STOP_Process> 
<Name>ServerMonitor</Name> 
<Name>Summit_ProxyServer</Name> 
<Name>Summit_ProxyConfiguration</Name> 
<Name>ProxySelfHealingService</Name> 
</STOP_Process> 

 
 Tag5 Section 

In this tag section, you can specify the DOS command details that you want to execute in 
Proxy Agent before upgrading files, such as stopping IIS server. 
<STOP_DOSCommand> 
<Name>NET STOP W3SVC</Name> 
<!--<Name>regsvr32 /u /s ʺ*INSTALLED_PATH*\bin\summitBackup.dllʺ</Name>--> 
</STOP_DOSCommand> 
 

Note:                                                                                                                                                 
You can use the DOS command for unregistering DLL files, if required. 

 
 Tag6 Section 

In this tag section, you can specify the process name (process name without extension) in 
<Name> tag to start the process after upgrading the files. 
<START_Process> 
<Name>ProxySelfHealingService.exe</Name> 
</START_Process> 
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 Tag7 Section 
In this tag section, you can specify the service name in <Name> tag to start the service after 
upgrading the files 
<START_Service> 
<Name>JobScheduler</Name> 
</START_Service> 
 

 Tag8 Section 
In this tag section, you can specify the DOS command details that you want to execute after 
upgrading files, such as starting IIS server. 
<START_DOSCommand> 
<!--<Name>regsvr32 /s ʺ*INSTALLED_PATH*\bin\summitBackup.dllʺ</Name> 
<Name>RMDIR ʺ*INSTALLED_PATH*\bin\*AUTO_UPDATE_PATH*ʺ /S /Q</Name>--> 
<Name>NET START W3SVC</Name> 
</START_DOSCommand> 
 

 Tag9 Section 
In this tag section, you can specify the list of variables that can be used in 
START_DOSCommand and STOP_DOSCommand tags. 
1.*INSTALLED_PATH* eg: c:\Program Files (x86)\SUMMUS\Proxy Agent 
2.*AUTO_UPDATE_PATH* AutoUpdate_634834358735511795 
*INSTALLED_PATH*\bin\*AUTO_UPDATE_PATH*  
eg: c:\Program Files (x86)\SUMMUS\Proxy Agent\bin\AutoUpdate_634834358735511795 

 
3.*AUTO_UPDATE_BACKUP_PATH* AutoUpdate_Backup_634834358742412190 
*INSTALLED_PATH*\bin\*AUTO_UPDATE_BACKUP_PATH* 
eg: c:\Program Files (x86)\SUMMUS\Proxy 
Agent\bin\AutoUpdate_Backup_634834358742412190 
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